User Guide

for SX-200® EL/ML Superset™ 7000
Industry Canada Notice

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

NOTICE

The information contained in this document is believed to be accurate in all respects but is not warranted by Mitel Corporation (MTEI). The information is subject to change without notice and should not be construed in any way as a commitment by MTEI or any of its affiliates or subsidiaries. MTEI and its affiliates and subsidiaries assume no responsibility for any error or omission in the document. Revisions of this document or new editions of it may be issued to incorporate any such changes.

WARNING

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the F.C. Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Nothing in this document may be reproduced in any manner, either wholly or in part for any use whatsoever, without written permission from Mitel Corporation.

PN 9119-953-012-NA
May 1999, Issue 3
DOS™ and Windows™ are Trademarks of Microsoft Corporation
SUPERSET™, SUPERSET™ 7000 and TALK 70™ are Trademarks of MTEI Corporation

™, © Trademark of MTEI Corporation.
© Copyright 1999, MTEI Corporation.
All rights reserved. Printed in Canada.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who Should Read This Guide?</td>
<td>vii</td>
</tr>
<tr>
<td>What you need to know</td>
<td>vii</td>
</tr>
<tr>
<td>Where You Can Find More Information</td>
<td>vii</td>
</tr>
<tr>
<td>For attendants</td>
<td>vii</td>
</tr>
<tr>
<td>For technicians</td>
<td>vii</td>
</tr>
<tr>
<td>Conventions Used in this Guide</td>
<td>vii</td>
</tr>
<tr>
<td><strong>Installing the SUPERSET™ 7000</strong></td>
<td>1</td>
</tr>
<tr>
<td>SUPERSET 7000 Application Package Components</td>
<td>3</td>
</tr>
<tr>
<td>What You Need to Run SUPERSET 7000</td>
<td>3</td>
</tr>
<tr>
<td>PABX Programming</td>
<td>4</td>
</tr>
<tr>
<td>Installing the TALK TO® Card</td>
<td>4</td>
</tr>
<tr>
<td>Installing the SUPERSET 7000 Application Software</td>
<td>4</td>
</tr>
<tr>
<td><strong>About the Console</strong></td>
<td>5</td>
</tr>
<tr>
<td>Introduction</td>
<td>7</td>
</tr>
<tr>
<td>Console Components</td>
<td>7</td>
</tr>
<tr>
<td>Console Monitor</td>
<td>7</td>
</tr>
<tr>
<td>Console Keyboard</td>
<td>8</td>
</tr>
<tr>
<td>Console Handset</td>
<td>9</td>
</tr>
<tr>
<td>Starting and Closing the SUPERSET 7000 Application</td>
<td>10</td>
</tr>
</tbody>
</table>
# Table of Contents

Adjusting the Console  ................................................................. 11
  Returning to the Main Screen .................................................. 11
  Adjusting the Ringer Volume and Cadence .................................. 11
  Adjusting the Handset Volume .................................................. 12
  Turning the Console Bell (Ringer) Off/On ................................... 12
  Switching to Night/Day Service ................................................ 12
  Setting the Console Language .................................................. 13
  Attendant Console Lockout ...................................................... 13
  Using Auto Answer ...................................................................... 14
  Reconfiguring the Console ........................................................ 14

**CALL HANDLING** ................................................................. 15

Call-Handling Keys ..................................................................... 17
Answering Calls .......................................................................... 18
  New Call Indication .................................................................... 19
  When Multiple Calls Are Waiting .............................................. 19
Extending (Transferring) Calls ....................................................... 20
  Misdialed Numbers .................................................................... 20
  Reaching a Busy Destination or an Extension with Do Not Disturb Activated ........................................ 21
  Reaching an Extension with an Advisory Message ...................... 22
Placing Calls ............................................................................... 22
Placing a Call on Hold .................................................................. 23
  Hold Recall ................................................................................ 24
  Hold Pickup ............................................................................... 24
  Stacked Hold ............................................................................ 24
Setting up Conferences and Call Splitting ...................................... 25
Answering Recalls ....................................................................... 26
Answering Intercepts to the Console ............................................ 27
Paging from the Console ............................................................... 27
  PA Paging ................................................................................ 27
  Extension Paging ....................................................................... 28
Setting and Canceling Do Not Disturb on an Extension .................. 28
Setting and Canceling Message Waiting on an Extension ................ 29
Overriding Busy or Do Not Disturb .............................................. 29
Using the Phone Book .................................................................. 30
Using Redial ............................................................................... 31
Setting up Serial Calls .................................................................. 31
Table of Contents

Using Tone Signaling ......................................................... 32
Flashing on Trunks .......................................................... 32
Answering a Call with Night Service Enabled ....................... 33
Using Directed Call Pickup .................................................. 33
Multiple Console Operation .................................................. 34
   Inter-Console Calls and Transfers .................................. 34
   Centralized Attendant Service (CAS) ............................... 34
Voice mail ................................................................. 35

**USING SYSTEM FUNCTIONS** ......................................... 37
Viewing System Alarm Information ..................................... 39
Viewing 911 Call Alarms ................................................... 40
Setting System Date and Time ........................................... 41
Canceling All Call Forwarding .......................................... 42
Canceling All Callbacks .................................................... 42
Changing DISA Codes ...................................................... 43
Setting up System-Abbreviated Dialing Numbers .................. 44
Setting up Night Answer Points ........................................ 45
Displaying the System Identification ................................... 46
Displaying the Console Identity ......................................... 46
Accessing Applications .................................................... 47

**USING EXTENSION FUNCTIONS** ................................. 49
Setting/Canceling Call Forwarding .................................... 51
Setting/Canceling Do Not Disturb ..................................... 52
Setting/Clearing Message Waiting ...................................... 53
Setting and Clearing Advisory Messages ............................ 54
Taking an Extension Out of Service ................................... 55

**USING TRUNK FUNCTIONS** ........................................ 57
Viewing Trunk Status ...................................................... 59
Viewing Trunk Group Busy Status ..................................... 60
Accessing Specific Trunks ................................................ 61
Taking Trunks Out of Service .......................................... 62
# Table of Contents

## Hotel/Motel Features ............................................. 63
- Displaying and Changing Room Data .................................. 65
- Listing/Counting Rooms by Occupancy and Condition Status ........... 67
- Changing Room Occupancy and Condition Status .......................... 68
- Setting and Canceling Wake-up Calls .................................. 69
- Setting Room Call Restrictions ...................................... 70
- Blocking Room-to-Room Calls ....................................... 71
- Displaying or Clearing the Message Register .......................... 71
- Printing Reports .................................................. 72

## Appendix A: Using the Phone Book Editor ......................... 73
- About the Phone Book Editor ........................................ 75
- Starting and Closing the Phone Book Editor ............................ 75
- Adding a New Entry ................................................ 76
- Deleting an Entry .................................................. 77
- Finding an Entry .................................................... 77
- Changing an Existing Entry ......................................... 78
- Showing All Entries ................................................ 78
- Printing the Phone Book ............................................. 78

## Appendix B: Reference ............................................... 79
- Telephone Directory .................................................. 81
- Abbreviated Dialing List ............................................ 82
- Class of Service/Restriction ......................................... 83
- Console Screen Abbreviations ....................................... 84
- System Messages for SUPERSSET Display Telephones ................. 85
- Glossary ........................................................... 86
- Tone Demonstration ................................................ 88
- Trunk Identification ............................................... 90

## Index .............................................................. 91
**Who Should Read This Guide?**

This guide is for attendants who use the SUPERSET™ 7000 Attendant Console and for technicians who install it.

**What you need to know**

As an attendant, you should have some experience using applications for Windows-based PCs. Technicians should know how to install software on a PC.

**Where You Can Find More Information**

**For attendants**

SUPERSET 7000 Attendant Quick Start Guide (PN 9119-953-011-NA) - describes the most frequently used SUPERSET 7000 call-handling procedures.

SUPERSET 7000 Attendant’s Quick Reference Guide (PN 9119-953-017-NA) - provides a keystroke summary of all console functions.

SUPERSET 7000 Attendant Tutorial - (PN 9119-500-013-NA) – introduces the SUPERSET 7000 to first-time users.

**For technicians**

SUPERSET 7000 Installation Guide (PN 9119-953-005-NA) - describes how to install the Mitel PC TALK TO® card and software.

SX-200® System Practices (PN 9109-953-051-NA) - contains information on installing and programming the SX-200.

**Conventions Used in this Guide**

This guide uses the following conventions to differentiate between the two types of console keys:

- Fixed-function keys appear in bold letters—for example, **Answer** or **Hold**.

- Variable function keys (called Softkeys) appear in bold letters within brackets—for example, **[Bell On]** or **[Conference]**.
Installing the *SUPERSET 7000*
SUPERCSET 7000 Application Package Components

The SUPERCSET 7000 Application Package consists of the following items:

- One TALK TO BX card with installation instructions.
- A 5¼-inch and a 3½-inch floppy disk containing the application software.
- A 3½-inch floppy disk containing a tutorial that introduces the SUPERCSET 7000 Attendant Console.
- Two sets of keyboard overlays and decals. The overlay identifies the keys used for call handling and fits around the keys on your keyboard. The decals serve the same purpose but are applied directly to the keys.
- One Mitel 400-series handset and cord.
- SUPERCSET 7000 Attendant Console User Guide
- SUPERCSET 7000 Attendant Console Quick Start Guide
- SUPERCSET 7000 Attendant Console Quick Reference Guide

Use only a Mitel-supplied 400-series handset and cord or optional headset with the SUPERCSET 7000 application.

What You Need to Run SUPERCSET 7000

The SUPERCSET 7000 application runs on a PC that meets the following minimum requirements:

- 80486/66 MHz processor with 8MB of RAM and Windows™ 3.1. (A Pentium processor with Windows 95 and 16MB of RAM are recommended.)
- VGA monitor
- 3½ inch floppy drive
- An AT 101 enhanced keyboard
- An ISA slot for the TALK TO card

A sound card is optional; having one allows you to adjust the console ringer volume and cadence.

The SUPERCSET 7000 application will not run under Windows NT™.
Installing the SUPERSET 7000

PABX Programming

The SUPERSET 7000 requires no special PABX programming. Program the PABX as if the SUPERSET 7000 was a SUPERCONSOLE 1000® Attendant Console.

Installing the TALK TO Card

The TALK TO card must be installed before the SUPERSET 7000 application software. Refer to the documentation supplied with the card for installation instructions.

Installing the SUPERSET 7000 Application Software

Perform the following procedure only if you are a qualified service technician.

To install the SUPERSET 7000 application software:

1 - Verify that Windows 3.1 or later is installed on the PC. If it is not installed, install it before proceeding to the next step.

2 - Insert the SUPERSET 7000 disk in the floppy drive.

3 - From the Start menu (Windows 95) or the File menu or Program Manager (Windows 3.1), choose the Run command.

4 - In the Run dialog box, type the floppy disk drive letter followed by \setup

For example, if the drive letter is A, type A:\setup

5 - Click OK.

6 - Follow the on-screen instructions.

Be sure to check the Readme file installed with the application. It contains information unavailable when the user guide was printed.

Make a backup copy of the application software and store it in a safe place. Use the DOS Backup command or the Microsoft Backup utility (Windows 95 only) for this. For more information, consult the documentation supplied with the PC.
About the Console
Introduction

The SUPERSET 7000 is an attendant console application for Windows-based PCs. It features a built-in telephone directory of system users and an intuitive user interface for smooth, efficient call handling.

A note about feature availability

The features available on your telephone system have been selected by your company and may not include all the features described in this guide.

Console Components

Your SUPERSET 7000 Attendant Console consists of a personal computer (PC) with monitor and keyboard, keyboard labels, and a handset and cord.

The monitor displays call-handling prompts and call status information. Use the keyboard for all call-handling activities, including dialing. Use the handset to talk with callers.

Console Monitor

The SUPERSET 7000 window is divided into four areas:

- The Status area at the top of the window displays the date and time, number of calls waiting, the console bell (ringer) status, and the Day/Night service status of the console. It also displays alarms when a problem with the system or console occurs.

- The Application area is divided into four sections: The top two sections display information about calls on hold and a directory of extension users in your organization. The bottom two areas indicate the “Source” (calling party) and “Destination” (called party) of all calls handled by the console.

- The Command and Response area displays command prompts and system messages.

- The Softkey area at the bottom of the screen displays the Softkey labels. The labels correspond to the Function keys F1 to F10 on your keyboard. See the next section for more information about the Softkeys.
About the Console

**Console Keyboard**

The *SUPERSET 7000* keyboard is divided into logical groupings of keys that allow quick access to attendant and PC functions.

- **Dialpad keys** - used to dial telephone numbers. (You must have Num Lock on to use the dialpad.)
- **Typing keys** - used primarily to enter names when using the Phone Book.
- **Cursor keys** - moves the bar (cursor) that is used to highlight items on the screen for selection or indicates where characters you type will appear.
- **Call-handling keys** - fixed function keys that are used to manage calls and include Page, Block, Hold, Cancel, Function, Retrieve, Release and Answer.
- **Softkeys** - used to enter commands. The commands available change with different stages of call processing. For example, if F8 is labeled Override, pressing the eighth softkey lets you override a busy extension's conversation. At another time, the same key, F8, could be labeled Night 1. Now, pressing F8 puts the console into night service.
- **Volume Adjustment keys** - used to increase or decrease the handset volume.
- **Dial # key** - used to dial the pound (#) symbol when necessary.
Console Handset

The SUPERSET 7000 Attendant Console is equipped with a handset and cord. A Mitel-approved headset is also available for use with the console.
About the Console

Starting and Closing the SUPERSET 7000 Application

To start the SUPERSET 7000 application:

1. Start Windows.
2. Do one of the following:
   ✦ On PCs with Windows 3.1, open the Program Manager, select the SUPERSET 7000 group icon, and then double-click the SUPERSET 7000 icon.
   ✦ On PCs with Windows 95, click the Start button, point to Programs, and then to SUPERSET 7000, and then click SUPERSET 7000.

To close the SUPERSET 7000 application:

Do one of the following:
   ✦ On the File menu, click Exit.
   ✦ Double-click the control box in the upper-left corner of the SUPERSET 7000 application window.
Adjusting the Console

RETURNING TO THE MAIN SCREEN

The main screen is displayed during most call-handling operations. When you access an application such as Phone Book or an operation through the Function key, you can return to the main screen in two ways: You can back up through the previous screens or automatically return to the main screen with one keystroke.

To return to the main screen:

Do one of the following:

♦ Press [BACKUP] repeatedly to back up through the screens and return to the main screen.

♦ Press [Exit] to return to the main screen to cancel and re-execute an operation.

ADJUSTING THE RINGER VOLUME AND CADENCE

If your PC has a sound card and the SUPerset 7000 is configured to use it, you can can adjust the volume and cadence of the ringer. Use the Options command in the File menu to specify that you want to use the sound card.

To adjust the ringer volume while the console is ringing:

♦ Use the Volume Control supplied with the sound card.

To adjust the ringer cadence:

1. Select Options from the File menu.

2. Select a ringer cadence from the Warble list, and then click Test to hear your selection.

3. Select OK.

You must restart Windows before the new ringer cadence will take effect.
About the Console

Adjusting the Handset Volume

You can increase or decrease the audio level of the handset during a call. When you end the call, the volume returns to a default level.

To adjust the handset volume:

- Press the [-] key repeatedly to lower the volume or the [+] key to increase it.

Turning the Console Bell (Ringer) Off/On

When the bell is off, the C/W indicator in the Status area is the only indication that calls are waiting to be answered.

To turn the bell on or off:

1 - Press Function.
2 - Press [Bell Off] or [Bell On].

Switching to Night/Day Service

Incoming calls that normally ring the console during the day can ring another answering point at night. Your system may have one or two night service modes called Night 1 and Night 2. The mode you should select depends on system programming.

Any attendant can switch the system into night or day service. When the system is in night service, the night status indicator (Night 1 or Night 2) displays on all consoles.

To switch to night or day service:

1 - Press Function.
2 - Press [Att Function].
3 - Press [Chg Service].
4 - Press [Night 1], [Night 2], or [Day Service] as required.
5 - Press [Exit].

You can change the Night 1 and Night 2 answering points for individual trunks from the console. For more information, see Setting up Night Answer Points on page 45.
Adjusting the Console

**Setting the Console Language**

You can display the call-handling information and softkey prompts in English, French or Spanish.

*To change languages:*

1 - Press **Function**.

2 - Press **[LANGUAGE]**.

3 - Press the softkey that corresponds to the language you want.

**Attendant Console Lockout**

You can enter an access code to restrict the capabilities of the attendant console. This prevents system tampering via the console when you leave it unattended—for example, during breaks. When the console is locked out, it cannot be used to place outgoing trunk calls or to access console functions, except 911 Call alarms. You can still use the console to place internal calls and to answer incoming trunk calls.

*To lock out the console (cannot have calls connected):*

* Enter the console Lockout access code. (Ask your communications department for the code.)

   The screen displays “Console in Restricted Service.”

*To return the console to normal operation:*

* Re-enter the console Lockout access code.
About the Console

**Using Auto Answer**

When Auto Answer is on, you can automatically answer new calls by releasing the previous call. The Status area on the console screen indicates whether Auto Answer is on or off.

*To turn Auto Answer on or off:*

♦ Select **Options** on the **Configure** menu, and then click **Auto Answer**.

*To use Auto Answer:*

♦ Press **Release** to automatically answer the next incoming call.

*To bypass Auto Answer:*

♦ Press **Cancel** to avoid automatically answering the next incoming call.

You cannot bypass Auto Answer when transferring calls. To transfer a call, you must press **Release**; pressing **Cancel** will not transfer the call.

Pressing **Release** when calls are waiting answers the call that has been in the queue longest.

**Reconfiguring the Console**

You can change the options selected during the installation of the SUPerset 7000 application at any time. These options allow you to specify a different IRQ setting and keyboard type and to enable or disable features such as Auto Answer.

*To reconfigure the console:*

1. Choose **Options** from the **Configure** menu.

2. Make the required changes to the settings. (See the online Help for information about the settings. To locate the information, click the **Search** button in the Help window, and then type Configure.)

3. Choose **OK** to save the changes.
Call Handling
Call-Handling Keys

The call-handling keys consist of eight fixed-function keys and the dialpad keys. A template that indicates the location of the call-handling keys is provided with your SUPERSET 7000 application. You may also use the supplied decals and apply the key names directly to the keys.

The forward slash [/] key on the dialpad is used to dial pound (#). You must have Num Lock on to use the dialpad.
Call Handling

Answering Calls

Ringing and a C/W indicator in the upper-right corner of the screen signal the arrival of a call. The number next to the C/W indicator tells you how many calls are waiting to be answered.

The information displayed next to the softkey prompts F1 to F10 indicate the actions you can take by pressing the corresponding softkey.

For example, you can answer an outside (trunk) call by pressing [LDN 1] (Listed Directory Number 1), or an internal (extension) call by pressing [DIAL 0].

The following softkey prompts can accompany an incoming call:

- [RECALL]
- [INTERNAL]
- [DIAL 0]
- [PRIORITY 0]
- [NIGHT ANS]
- [LDN 1], [LDN 2], . . . [LDN 9]
- or any pre-programmed customer-specific information (for example, your company may choose to display [LINE 1] instead of [LDN 1]).

The [INTERNAL] prompt indicates calls to a specific attendant made by dialing the console’s internal directory number (as opposed to dialing “0”). The other prompts are explained elsewhere in the guide.

To answer calls:

Do one of the following:

- Press Answer to answer the first call in the queue.
- Press a softkey (F1 – F10) to answer a specific type of call.

The SOURCE area on the screen shows the extension number and name for an internal call, or a trunk number for an external call.

The DESTINATION area remains blank until you dial a destination number.
New Call Indication

When you are engaged in a call, a single burst of ringing signals the next incoming call. Subsequent calls do not ring the console, but the C/W indicator on the screen tells you have additional calls waiting.

The console can be programmed to provide a single burst of ringing at regular intervals when calls are waiting.

When Multiple Calls Are Waiting

You cannot answer a new call until the one you are engaged in is transferred, disconnected, or put on hold.
Call Handling

Extending (Transferring) Calls

When a caller requests to speak to someone, ask the caller to wait a moment, and then transfer the call to the requested destination.

The forward slash (/) key on the dialpad is used to dial pound (#). You must have Num Lock on to use the dialpad.

To transfer a call:

1 - Dial the destination number using the dialpad keys.
   The caller is automatically placed on hold while you complete the transfer.

2 - When you hear ringing, press Release to connect the caller to the destination and release the console from the call.

Misdialed Numbers

If you do not want to complete dialing, or if you misdial a number, either

- Press the ← key to erase the misdialled digits, and then dial the correct number.

- or-

- Press Cancel to return to the Source party, and then redial the number.
Extending (Transferring) Calls

REACHING A BUSY DESTINATION OR AN EXTENSION WITH DO NOT DISTURB ACTIVATED

If the called destination is busy or the extension has Do Not Disturb activated, the DESTINATION area on the screen will show “Busy” or “DND.”

In both cases, your options for handling the call are the same, except for the Callback option, which only applies when calling a busy destination.

To handle a call to a busy destination or an extension with Do Not Disturb activated:

♦ Press [SOURCE] to return to the caller requesting the transfer.
♦ Press Cancel to disconnect the destination so that you can dial a new one.
♦ Press Release to camp the caller on to the busy destination or disconnect the Source. (For an explanation of camp-on, see page 86.) If the transfer is not allowed, you will hear a beep tone and “CANT” will display on the console screen.
♦ Press [OVERRIDE] to break into the busy extension. For more information on using Override, see page 29.
♦ Press [SEND MSG] to send a message waiting indication to the called extension. For more information on Message Waiting, see page 29.
♦ Press [CALLBACK] to receive notification when the destination is free.

If you reach a busy extension or you are placing an outside call and all of the trunks are busy, you can request an automatic Callback. The system monitors the line and rings the console when the line becomes free. When you answer a Callback at the console, the SOURCE area on the screen will show “CALLBACK.” Callbacks on outside calls are used when all system trunks are busy, not when the called party is busy.
Call Handling

Reaching an Extension with an Advisory Message

Users with a SUPERSET display phone can show a short message, called an Advisory Message, on other display phones or consoles that call their phone. When you call an extension with an Advisory Message, the message appears in the DESTINATION area on the screen as follows:

3070 S.BERRY IN A MEETING RINGING

In this example, the user has left the message “In a meeting” on his or her phone. For a list of other Advisory messages, see page 85. See also Setting/Clearing Advisory Messages on page 54.

Placing Calls

To place a call:

1 - Dial the destination number using the dialpad keys.
   The dialed number appears in the DESTINATION area on the screen.

2 - After you complete the call, press Release to disconnect it from the console.

The forward slash /[key on the dialpad is used to dial pound (#). You must have Num Lock on to use the dialpad.
Placing a Call on Hold

You can place up to six calls on hold. The On Hold area on the screen shows the Hold slot number (1-6), the name of the caller (internal calls only) and the extension or trunk number.

To place a call on hold:

1. Inform the caller that you are placing the call on hold.
2. Press Hold.

To retrieve a call on hold:

1. Press Retrieve.
2. Do one of the following:
   - Press the Hold slot number (1-6) of call you want to retrieve.
   - Press Retrieve again to retrieve the longest-held call.
Call Handling

**Hold Recall**

If a call is left on hold longer than a specified time, it returns to the console as a recall. The console beeps and the Hold slot number on the screen flashes to indicate the recall.

To answer the recall, follow the procedure above for retrieving a call on hold.

**Hold Pickup**

Extensions can pick up calls placed on hold at the console by dialing a Hold Pickup code and the hold location. The call and the code required to retrieve it are usually announced using paging. For more information, see page 27.

**Stacked Hold**

When an extension has a call on hold or is in a conference call and dials the attendant, the SOURCE area on screen will indicate a held or conferenced call. For example, a held call would show as:

Pressing [**Conf**] establishes a conference call involving the console and extensions 3456 and 3056.
Setting up Conferences and Call Splitting

When you are setting up a call between two parties, you may want to conference the call (speak with both parties at the same time). Once you establish the conference, you can speak privately to either party by splitting the conference.

**To conference a call:**

1. Start with a call involving one of the parties you want to include in the conference.
2. Call the other party.
3. Press [CONF].

**To split a conference call:**

- Press [SOURCE] to speak privately to the first party or [DEST] to speak privately to the other party.

**To release the console from a conference call:**

Do one of the following:

- Press Release to connect both parties together and then release them from the console.
- Press Cancel to release the parties from the console without first connecting them.
Call Handling

Answering Recalls

When a call is transferred and the extension is busy or does not answer, the call returns to the console within a specified time or is directed to the extension’s voice mailbox (if available).

To answer a “No Answer” recall:
1 - Press Answer or [RECALL].
2 - Inform the caller that the destination is not answering.
3 - Do one of the following:
   - Press [RING AGAIN] to redial the same destination.
   - Dial a new destination, and then press Release.
   - Press Cancel to disconnect the Source party.

To answer a “Busy” recall:
1 - Press Answer or [RECALL].
2 - Inform the caller that the destination is busy.
3 - Do one of the following:
   - Press Cancel to disconnect the Source party.
   - Press Release to transfer the call to the same destination again.
   - Press [DEST] to reconnect with the busy destination.
4 - If you pressed [DEST], do one of the following:
   - Press [OVERRIDE] to break into the busy extension.
   - Press [SEND MSG] to send a message waiting indication to the busy extension.
   - Press [SOURCE] to connect to the source party.
   - Press [CALL BACK] to be notified when the extension is free.
   - Press Release to camp the Source on to the destination again. (See page 86 for an explanation of camp-on.)
   - Press Cancel to clear the destination and dial a new extension number.
Answering Intercepts to the Console

Misdialed calls from extensions, or calls to extensions with Do Not Disturb activated, could ring the console depending on system programming. When you answer the call, the screen will show the reason for the interception:

- DND INT for calls to an extension with Do Not Disturb activated.
- ILL # INT for illegal number dialed.
- VAC # INT for vacant (unassigned) number dialed.

Paging from the Console

Two types of paging are available from the console: Public Address (PA) Paging and Extension Paging.

PA Paging

If your system has external paging equipment, you can place a call on hold and then page for someone to pick up the call from the console Hold slots. You can also use PA Paging to make public announcements.

Your paging equipment may be set up to access several areas or "zones." If so, you use the Page key to speak to all zones at once and access codes to speak to individual zones. These codes are available from your communications department.

To page someone to pick up a call on hold at the console:

1 - Place the Source call on hold. (See page 23.)
2 - Press and hold Page.
3 - Do one of the following:
   - If you have only one paging zone, announce the Hold Pickup access code and the highlighted Hold slot number.
   - If you have more than one page zone, dial the two-digit paging code (dial 00 for all zones), and then announce the Hold Pickup access code and the Hold slot number.
   - If the paging equipment is already in use, you can press [OVERRIDE] to interrupt the page in progress.
4 - Release Page.
Call Handling

**Extension Paging**

Extension Paging allows you to page extension users using their telephone speakers. This feature is available only for paging *SUPERSET* telephones that are programmed as key system telephones.

You can use Extension Paging to page a specific extension (Directed Page), multiple extensions assigned to a group (Group Page), or all extensions (All Set Page).

*To page an extension:*

1 - Press **Set Page**.

2 - Do one of the following:

   - To page a specific extension, dial the extension number.
   - To page a group of extensions, press **[GROUP PAGE]**, and then press the two-digit group number.
   - To page all extensions, press **[ALL SET PAGE]**.

3 - Make the page.

**Setting and Canceling Do Not Disturb on an Extension**

Do Not Disturb (DND) prevents calls from ringing a user’s extension. You can set and cancel DND on a user’s extension while you are on a call with the user.

*To set or cancel DND on an extension:*

1 - While connected to the extension, press **[No Distb]**.
   
   “DND” appears next to the extension information on the screen to indicate that Do Not Disturb is set.

2 - Press **Release**.

You can also set and cancel DND without calling the extension. For more information, see page 52.
Setting and Canceling Message Waiting on an Extension

If an extension is busy or the user does not answer, you can send a notice to let the user know a message is waiting at the console. You can also cancel messages you left at an extension.

To set or cancel Message Waiting on a ringing or busy extension:

1 - Press [SEND MSG] to set Message Waiting or [CLEAR MSG] to clear it.

   “MSW” appears next to the extension information on the screen to indicate that Message Waiting is set.

2 - Press Release.

If you are setting Message Waiting on a SUPERSET display telephone, an indication appears on the display to let the user know a message is waiting at the console. On other types of telephones, either a flashing lamp or distinctive ringing every 20 minutes indicates that a message is waiting.

Overriding Busy or Do Not Disturb

The Override feature allows you to intrude into a busy extension or an extension with Do Not Disturb (DND) active.

To use Override:

1 - Press and hold [OVERRIDE].

   If you are overriding a busy extension, both parties hear a long beep, and then you enter the conversation. You will remain connected to the conversation until you release the [OVERRIDE] softkey.

   If you are overriding an extension with (DND) active, you will hear ringing.

2 - Press Cancel or Release to disconnect the console from the busy extension.

   If the busy extension hangs up while you are pressing [OVERRIDE], you will hear fast busy tone and the screen will show “Hung Up” instead of “Busy.”
Call Handling

Using the Phone Book

The Phone Book allows you to find and call an extension user by typing the user’s name or a portion of it.

To use Phonebook to look up an extension user:

1 - Press **Phone Book**.

2 - Type the person’s name or a portion of it (the portion must include the first letter).

   If the name is not unique, use the ↑ or ↓ keys to scroll through the list until you have highlighted the one you want.

3 - Press **[LOOKUP]**.

   The name(s) display in the Phone Book area.

   ![Phone Book interface](image)

   To increase the size of the Phone Book area (and display more information), press **[CHANGE SIZE]**.

4 - To the call the selected extension user, press **[CALL]**.

5 - Press **[EXIT]**.
Using Redial

You can redial the last manually dialed number (internal or external) by pressing a single key.

To redial the last number:

♦ Press [REDIAL].

Setting up Serial Calls

The Serial Call feature allows outside callers to talk to more than one extension user in sequence without redialing the main business number each time.

To set up a serial call while connected to an outside call:

1 - Tell the caller to remain on the line after completing each call.
2 - Press [SERIAL CALL].
   “SER” displays in the Source area on the screen to indicate a serial call is being set up.
3 - Dial an extension number.
4 - Press Release.
   When the extension user hangs up, the outside call returns to the console as a recall.
5 - When the call returns to the console, press [RECALL].
6 - Dial the next extension number, and then press Release.
7 - When all calls are completed, press [SERIAL CALL] and then Release.
Call Handling

Using Tone Signaling

You may have noticed that when you dial a number at the console, you do not hear any of the tones or pulses normally associated with telephones. This is because the console "communicates" with the rest of the telephone system using a different type of signaling.

However, there are times when telephone equipment, either in or outside your office, needs to receive tones to complete a call. Typically, special services such as Voice mail systems (described on page 55) require information in the form of tones before allowing access.

To enable tone signaling while connected to a service requiring tones:

1 - Press [TONES ON].
2 - Dial the required code.
3 - When you complete the call, press [TONES OFF] to turn off tone signaling.

Flashing on Trunks

A trunk flash is a signal sent to another telephone system to do something such as place a call on hold. You may need to use this feature when you have a call from another PABX in your own company network, and you want to transfer it to the originating PABX or to a third one.

You can flash only when you are talking on a trunk to another trunk in a two-party call.

To flash on a trunk for further dialing:

1 - Press [FLASH].
2 - Dial the required number.
3 - Press Release.
Answering a Call with Night Service Enabled

When the console is in Night Service, incoming calls ring night bells or some other night answering point. These calls can still be answered from the console even though they do not ring the console bell.

The night answer point is programmed at the system level. If required, you can change the night answering point for individual trunks from the console. For more information, see page 45.

To answer a call when the console is in Night Service:

♦ Press [NIGHT BELL].

Using Directed Call Pickup

Directed Call Pickup allows you to answer a call ringing at an extension. You can also use this feature to retrieve a call that you transferred to the wrong extension.

To pick up a call ringing at an extension:

1 - Dial the Directed Call Pickup code. (Your communications department can provide the code.)

2 - Dial the extension number of the ringing extension.

3 - Speak to the calling party.
Call Handling

Multiple Console Operation

When more than one console is in use at the same time, they will operate in one of two ways:

1 - Independent Operation

Consoles in this arrangement operate independently. Each console has unique hold slots and incoming calls ring a specific console. A recall to the attendant returns only to the console that initially handled the call.

2 - Transparent Operation

With transparent operation, all consoles operate the same way. Recalls return to all consoles, not just the console that originally handled the call.

The consoles are also given privileges to read or cancel messages left at an extension by other extension users or the attendant. For more information about reading and canceling messages, see page 53.

Inter-console Calls and Transfers

An attendant can make and transfer calls to another attendant by dialing the console’s directory number, but not by dialing 0 (zero). Whether you are transferring calls to an extension or another attendant, the procedure is the same—see page 20 for instructions.

Inter-console calls cannot be put on hold.

Centralized Attendant Service (CAS)

CAS allows an attendant at one PABX to answer calls that arrive at another interconnected PABX. Except for recalls, CAS has no effect on the way you handle calls from the console. When a call from another PABX in a CAS system recalls the console, it appears as a “Dial 0” call. Keep this in mind when answering the recall as it may affect how you greet the caller.
Voice mail

A voice mail system connected to your telephone system does not affect the operation of the console. If a call is answered by such a system, you may be prompted to enter an access code or an identification number. Before responding to the prompt, you must turn on tone signaling using the [TONES ON] softkey. For more information, see Using Tone Signaling on page 32.
Using System Functions
Viewing System Alarm Information

An alarm indicator on the screen means a fault in the telephone system has occurred. You can read information about the nature and location of the fault from the console.

To read an alarm message:

1 - Press Function.

2 - Press [ALARM]. The screen shows, for example:

3 - Record all the alarm information.

Press [MORE...] to display additional information or other alarms. The Alarm indicator will continue to flash until all alarm messages have been display.

4 - Contact your communications department.

5 - Press [EXIT].

The system may be programmed to raise an alarm when an extension is left off-hook without a call too long. If so programmed, the console will ring with no calls waiting. To cancel the alarm and stop the ringing, press Function followed by [SHOW LOCKOUT], and then press [CLEAR].
Using System Functions

**Viewing 911 Call Alarms**

This feature raises an alarm at the console when an extension user places a 911 call and identifies the extension that placed the call. With this information, you can direct emergency services (for example, police or ambulance personnel) to the location from which the call was placed. When a 911 Call alarm is raised, the console rings and the screen shows,

“911 Call <Press FUNCTION Key for Details> ALARM”.

To read a 911 Emergency Call alarm message:

1 - Press **Function**.
2 - Press [Alarm], and then [Setup 911].
3 - Record the number of the extension from which the 911 call originated.
   - If additional 911 calls were made, press **MORE...** to view them. To delete the 911 alarm, press **CLR**.
4 - Contact the appropriate emergency services.
5 - Press **Exit**.

If an attendant console is in Attendant Console Lockout state, you can still access 911 alarm information, but you cannot clear the alarms.
Setting System Date and Time

You can change the date and time appearing on the console screen. The time displays either in 12- or 24-format depending on system programming.

To set the time:

1 - Press Function.

2 - Press [Att Function].

3 - Press [Set Time].

4 - Enter the current time using four digits (hh:mm).
   For example, for 9:30 enter 0930.

5 - Press [PM] if applicable.
   [PM] appears only if the system is set to 12-hour format, and the hour entered is in the range 01 – 12.

6 - Press [Set].
   [Set] appears only if the time has been entered correctly. You can use the ← key to make corrections.

To set the date:

1 - Press Function.

2 - Press [Att Function].

3 - Press [Set Date].

4 - Enter the current date in day/month/year format.
   For example, for December 12, 1999, enter 121299.

5 - Press [Set].
Using System Functions

Canceling All Call Forwarding

You can cancel Call Forwarding on all extensions in the system.

To cancel Call Forwarding on all extensions:

1. Press Function.
2. Press [ATT FUNCTION].
3. Press [MORE...].
4. Press [CAN. ALL FWD].

You can also set up Call Forwarding for individual extensions from the console.
For more information, see page 51.

Canceling All Callbacks

You can cancel Callback messages on all extensions in the system.

To cancel Callbacks on all extensions:

1. Press Function.
2. Press [ATT FUNCTION].
3. Press [MORE...].
4. Press [CAN. ALL CBK].
Changing DISA Codes

You can change the DISA (Direct Inward System Access) code that outside callers must dial to access system features.

To change the DISA access code:

1 - Press Function.
2 - Press [ATT FUNCTION].
3 - Press [MORE...].
4 - Press [DISA CODE].
5 - Enter the new access code.
6 - Do one of the following
   ♦ Press [SET] to confirm the new access code.
   ♦ Press [EXIT] to exit without changing the code.
Using System Functions

Setting up System-Abbreviated Dialing Numbers

Abbreviated dialing allows extension users to call a telephone number or enter a system access code by dialing a three-digit index number. You can program and display system-abbreviated dialing numbers from the console.

To program or display system-abbreviated dialing numbers:

1. Press **Function**.
2. Press **[ATT Function]**.
3. Press **[Abbr Dial]**.
4. Enter a three-digit index number from 000 to 999.
   Press ← to delete entry errors and then enter the correct number.
5. Press **[PRIVATE]** to not display the number when dialed.
6. Press **[ENTER]**.
7. Press **[CANCEL]** to change the existing number.
8. Enter the new number. (Include the outside line access code (e.g. “9”) and an area code, if applicable.)
   You can insert pauses in the numbers. Enter *9 for each 1-second pause; enter *1 for each 5-second pause.
   Press ← to delete entry errors, and then enter the correct number.
9. Press **[SET]**.
10. Repeat step 4 to 9 to program other numbers, or press **[Exit]** to end programming.
Setting up Night Answer Points

A night answer point is the number of an extension or other destination where incoming trunk calls will ring when the system is in Night Service. For more information about Night Service, see page 12.

To set up night answer points:

1. Press Function.
2. Press [ATT Function].
3. Press [More...].
4. Press [Flex Night].
5. Enter the trunk number.
6. Press either [Night 1] or [Night 2] to choose the night service mode.
7. Dial the destination number of the night answer point.
   The destination can be a telephone, an attendant console directory number, an LDN number on a console, a hunt group or a Night Bell directory number.
8. Do one of the following:
   ♦ Press [Set] to confirm the new number.
   ♦ Press [Exit] to exit without making changes.
Using System Functions

Displaying the System Identification

A System Identification Number may be assigned to your PABX. This number appears on Station Message Detail Reporting (SMDR) and traffic-measurement reports to identify your system when central polling equipment is used. It is usually unnecessary to change this number once it is entered.

To display or change the System Identification:

1 - Press Function.
2 - Press [ATT Function].
3 - Press [SYSTEM IDENT].
4 - Enter a new three-digit number if required.
5 - Press [SET] to confirm the new number.

Displaying the Console Identity

The console has an extension number which extension users can dial instead of "0" (zero), to call you. You can display the console extension number along with system software version.

To display the console extension number and the system software version:

1 - Press Function.
2 - Press [IDENTITY].
Accessing Applications

The Application function is primarily used by maintenance personnel or someone responsible for doing Customer Data Entry (CDE). Access to these functions requires a password.

To access the Application function:

1 - Press Function.

2 - Press [MAINTENANCE] or [CDE].

Your Communications Department will give you further instructions if you are required to do any Customer Data Entry.
Using Extension Functions
Setting/Canceling Call Forwarding

You can set up and cancel Call Forwarding on individual extensions from the console.

The instructions that follow apply to systems programmed with Split Call Forwarding, which allows you to specify different destinations for internal and external calls. If your system is programmed with another type of Call Forwarding, internal and external calls will both go to the same destination. Note that calls from the console are considered external.

To set or cancel Call Forwarding on an extension:

1 - Press **Function**.
2 - Press **[Att Function]**.
3 - Press **[Stations]**.
4 - Dial the number of the extension for which you want to set or cancel Call Forwarding.
   If you dial an invalid number, press **[Clear No.]**.
5 - Press **[Call Fwd]**.
6 - Do one of the following:
   ♦ Press **[Internal]** to set or cancel call forwarding of internal calls.
   ♦ Press **[External]** to set or cancel call forwarding of external calls.
7 - Do one of the following:
   ♦ Press **[Cancel]** to cancel the current call forwarding.
   ♦ Dial a destination and then select the type of call forwarding—Always, No Answer, etc.

To return to the main screen without making changes, press **[Exit]**.
Using Extension Functions

Setting/Canceling Do Not Disturb

Do Not Disturb (DND) prevents calls from ringing an extension. You can set and cancel DND on any extension in the system.

To set or cancel DND on an extension:

1. Press Function.
2. Press [ATT FUNCTION].
3. Press [STATIONS].
4. Dial the extension number.
5. Press [No Distb].

The screen shows “DND” to indicate that DND is set.

You can also set and cancel DND while on a call to an extension. For more information, see page 28.
Setting/Clearing Message Waiting

You can notify extension users that a message is waiting for them at the console. When the user returns and calls the console, “MSW” displays on the screen to indicate that there is a message waiting for that extension.

Use this feature if you know that the person you are trying to contact is out of the office. If you know that the person is in the office, use the Callback feature described on page 21.

To set or clear Message Waiting on an extension:

1 - Press Function.
2 - Press [ATT Function].
3 - Press [STATIONS].
4 - Dial the extension number.
5 - Do one of the following:
   ♦ Press [SEND MSG] to set message waiting.
   ♦ Press [CLEAR MSG] to clear message waiting.
6 - Press [EXIT].

Reading and Clearing Messages

Depending on your system’s programming, you may be able to read and clear messages left for an extension by another user or attendant console. Without this capability, you can only read and clear messages that you have set.

To read and cancel an extension’s messages:

1 - Press Function.
2 - Press [ATT Function].
3 - Press [STATIONS].
4 - Dial the extension number.
Using Extension Functions

5 - Press [READ MSG].

The absence [READ MSG] on the screen means that you are not authorized to read or clear messages other than those you have left.

The screen shows the number of messages at that extension, the extension number of the user that left the message, and when the message was left.

6 - Do one of the following:

♦ Press [NEXT MSG] to read the extension’s next message.
♦ Press [CLEAR MSG] to clear the message.
♦ Press [EXIT] to return to the main screen.

Setting and Clearing Advisory Messages

You can read Advisory Messages left on a SUPERSET display telephone and clear or change an existing message.

To read, set, or clear an Advisory Message:

1 - Press Function.
2 - Press [ATT Function].
3 - Dial the extension number.
4 - Press [SET UP MSG].
5 - Do one of the following:

♦ Press [On] to activate the currently displayed message.
♦ Press [Next] until the message you want to leave appears, and then press [On] to activate the message.

If the extension has an Advisory Message active, the message will appear on your screen. You can either press [Off] to clear the message or replace it with another one by pressing [Next] until the replacement message appears, and then pressing [On] to activate the message.
Taking an Extension Out of Service

You can take an extension out of service (busy it out) if there is a problem with that extension or the system. An out-of-service extension can neither make nor receive calls.

To busy out an extension:

1. Press Function.
2. Press [ATT FUNCTION].
3. Press [STATIONS].
4. Dial the extension number.
5. Press [BUSY OUT].
   If the screen shows “BUSY” instead of “IDLE” the extension is in use and will not be taken out of service until it becomes idle.
6. Do one of the following:
   ♦ Press [SET] to busy out the extension.
   ♦ Press [CLEAR] to return the extension to service.
Using Trunk Functions
Viewing Trunk Status

You can view trunk status information to determine the current assignment of services and features on a trunk.

*To view the current status of a trunk:*

1. Press **Function**.
2. Press **[ATT FUNCTION]**.
3. Press **[TRUNKS]**.
4. Enter the trunk number.
5. Press **[STATUS]** to view information about the trunk such as its Class of Service (COS) and Class of Restriction (COR).
6. Press **[Exit]**.
Using Trunk Functions

Viewing Trunk Group Busy Status

You can check the status of trunk groups to see which ones are busy. A maximum of 20 groups can be displayed at one time, either when the console is idle or during call handling.

To check the status of trunk groups:

1 - Press Trunk Status to view the first 20 trunk groups.

   The screen shows, for example:

   ![Trunk Status Screen]

   In this example, trunk groups 02, 05, 07 and 12 are busy.

2 - Press [MORE...] to display the next 20 groups.

   Repeat as required.

3 - Press [EXIT].
Accessing Specific Trunks

You can access a specific trunk and use it to make an outgoing call.

**To access a specific trunk:**

1. Press **Function**.
2. Press [ATT Function].
3. Press [Trunks].
4. Enter the trunk number.
5. Press [Enter].
6. Press [ATT Access].
7. Do one of the following:

   - If the trunk is free (as indicated by dial tone), dial the outside number.
   - If the trunk is busy, either press **FORCED RLS** to clear the trunk of the call, or press and hold down **OVERRIDE** to barge into the call. Both parties will hear a long beep before you enter the conversation.

Trunks that are designated as dictation trunks (M/MM leads), and in use, cannot be accessed.
Using Trunk Functions

Taking Trunks Out of Service

If may be necessary to take a trunk out of service (busy it out) if there are problems with that trunk or the system. You can busy out an idle trunk or one that is in use. Afterwards, you can return the trunk to service.

To busy out a trunk or return a trunk to service:

1 - Press Function.
2 - Press [ATT FUNCTION].
3 - Press [TRUNES].
4 - Enter the trunk number.
5 - Press [BUSY OUT].
6 - Do one of the following:
   ♦ Press [SET] to busy out the trunk.
   ♦ Press [CLEAR] to return the trunk to service.
Displaying and Changing Room Data

Room data includes occupancy and condition status (Vacant, Clean, Outgoing Call Restrictions, etc.) and the status of message waiting, wake-up call, and other services. You can change room data while the console is idle, or when you are connected to the room.

To display or change data for a room:

1. Press Function.
2. Press [GUEST ROOM].
3. Dial a room number (not necessary if you are already connected to the room).

The screen shows, for example:

In this example, room 2702 is occupied and clean, and allowed to make internal calls only.
Hotel/Motel Features

4 - Do any of the following:

- Press [CLR REG] to clear the message register count. (See page page 71.)
- Press [NO DISTB] to set Do Not Disturb and block incoming calls.
- Press [SEND MSG] to set or [CLEAR MSG] to clear the message waiting indicator on the room phone.
- Press [SET WAKE-UP] to set or [CLR WAKE-UP] to clear a wake-up call time. (See page 69.)
- Press [STATUS] to change the room’s Occupancy or Condition status (See Changing Room Occupancy and Condition Status on page 68.)
- Press [ROOM NUMBER] to display the status of another room. (This option is not available when the console is connected to a room.)
Listing/Counting Rooms by Occupancy and Condition Status

You can display a list of rooms by occupancy and condition status—for example, Vacant and Not Clean, or Occupied and Maid Present. The system also reports the total number of rooms that are in the state you specify. You can cycle through all rooms or start with a particular room number—for instance, the first room on the third floor.

To list all rooms by occupancy and condition status:

1. Press Function.
2. Press [GUEST ROOM].
3. Press the softkey that corresponds to the rooms you want to display—for example, to display all vacant and clean rooms, press [VAC/CLEAN Rm].

4. Press [MORE...] to display the next 10 rooms matching the specified states.

If a printer is attached to the console, you can print a list of all vacant or occupied rooms. For more information, see Printing Reports on page 72.
Hotel/Motel Features

To display a list of rooms beginning with a particular room number:

1 - Complete steps 1 to 4 above.
2 - Press [Room Number].
3 - Dial the number of the first of the rooms you want to display.

Changing Room Occupancy and Condition Status

You can change the occupancy and condition status of a room while the console is idle or while you are connected to the room.

The occupancy and condition states are as follows:

<table>
<thead>
<tr>
<th>Occupancy</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vacant</td>
<td>Clean</td>
</tr>
<tr>
<td>Occupied</td>
<td>Dirty</td>
</tr>
<tr>
<td>Reserved</td>
<td>Maid</td>
</tr>
<tr>
<td>Guaranteed</td>
<td>To Inspect</td>
</tr>
<tr>
<td></td>
<td>Out of Service</td>
</tr>
</tbody>
</table>

To change a room's occupancy and condition status:

1 - Press Function.
2 - Press [Guest Room].
3 - Dial the room number (not necessary if you are already connected to the room).
4 - Press [Status].
5 - Press the softkey that corresponds to the states you want to set—for example, to change a room from vacant to occupied press [Occupied].

The Maid status can only be changed from the room by dialing a code. Your system may be programmed to automatically change all “occupied and clean” rooms to “occupied and dirty” at a set time. Ask your communications department for information.
Setting and Canceling Wake-up Calls

Both the attendant and guest can set, change, and cancel wake-up calls for the guest room. The system does not distinguish whether a wake-up call is set, changed, or canceled from the attendant console or guest room telephone. So, for example, a guest can cancel a wake-up call that was set by the attendant and vice-versa.

You can set or cancel a wake-up call while the console is idle or while connected to the guest room.

If a printer is attached to the console, a report may print each time you set, change, or cancel a wake-up call.

To set or cancel a wake-up time while connected to the guest room:

1 - Press [SET WAKE-UP].
2 - Enter the time using four digits (hh:mm).
   For example, for 6:30 enter 0630.
3 - Do one of the following:
   ♦ Press [Set] to set the time as AM.
   ♦ Press [PM] to set the time as PM. ([PM] only appears if the system clock is set to 12-hour format, and the hour entered is in the range 01 – 12.)
4 - Press [Exit].
5 - Press Release.

To set or change a wake-up time when NOT connected to the guest room:

1 - Press Function.
2 - Press [GUEST ROOM].
3 - Dial the room number.
4 - Follow the steps from the previous procedure.
Hotel/Motel Features

To cancel a wake-up call:

1 - Press Function.
2 - Press [GUEST ROOM].
3 - Dial the room number.
4 - Press [CLR WAKE-UP].
5 - Press [EXIT].

Some display sets can set their own timed reminder. The above procedures will also clear or change a reminder already set by the user.

If the guest fails to answer the wake-up call, the system will ring the room twice more at five-minute intervals. If a third wake-up call goes unanswered or reaches a busy line, the system may generate a minor alarm at the console.

Setting Room Call Restrictions

You can restrict guests from placing local or long distance calls from their room phones. The procedure you use to set call restrictions depends on whether the hotel/motel is using a Property Management System.

If the hotel/motel is NOT using a Property Management System

1 - Press Function.
2 - Press [GUEST ROOM].
3 - Dial the room number.
4 - Press [STATUS].
5 - Do one of the following:
   ♦ Press [INTERNAL] to allow internal calls only.
   ♦ Press [LOCAL] to allow internal and local calls.
   ♦ Press [LONG DIST] to allow internal, local, and long distance calls.
Blocking Room-to-Room Calls

If the hotel/motel is using a Property Management System

1 - Press **Function**.
2 - Press **[GUEST ROOM]**.
3 - Dial the room number.
4 - Press **[RESTRICT O/G]**.
5 - The phone is restricted from making outgoing trunk calls.

**Blocking Room-to-Room Calls**

You can use the **Block** key to bar calls between guest rooms. Only room phones programmed with call blocking will be affected by this; ask your communications department for further information.

*To block room-to-room calls:*

♦ Press **Block**.

**Displaying or Clearing the Message Register**

The message register is a record of all external calls placed from a guest room telephone. You can display and clear a room’s message register while the console is idle or while connected to the guest room.

*To display or clear a room’s message register:*

1 - Press **Function**.
2 - Press **[GUEST ROOM]**.
3 - Dial the room number (not necessary if you are already connected to the room).
4 - Press **[CLR REGISTER]**.

If a printer is attached to the console, a report may print showing the contents of the register before it was cleared.
Hotel/Motel Features

Printing Reports

If a printer is connected to the console, you can request printed reports (audits) of message registers, room status and automatic wake-ups.

Each audit has its own format and some are printed automatically. For example, when a wake-up call is set, changed or canceled, the printer automatically records it.

To print a report:

1. Press Function.
2. Press [GUEST ROOM].
3. Press [AUDITS].
4. Select the report you want to print.
5. Press [EXIT].
Appendix A: Using the Phone Book Editor
About the Phone Book Editor

You use the Phone Book Editor to make changes to the online telephone directory.

Starting and Closing the Phone Book Editor

Before starting the Phone Book Editor, close the SUPERSET 7000 application.

To start the Phone Book Editor:

- Windows 3.1
  Double-click the Bookutil icon in the SUPERSET 7000 Program Group
- Windows 95
  Click the Start button on the task bar, point to Programs, SUPERSET 7000, and then click Bookutil.

The Phone Book Editor window opens.

To close the Phone Book Editor:

- Select Quit from the File menu or press ESC.
- Choose OK.
Appendix A: Using the Phone Book Editor

Adding a New Entry

To add a new entry

1. Choose New from the Edit menu or press F3.

2. Type the extension number and then press Enter.

   See the note below for further information.

3. Type the person's name (last name first, followed by first name) and then press Enter.

   Enter names in a consistent manner to ensure consistent outcomes for Phone Book searches.

4. Type any additional information such as the person's job title, department name, location, etc.

   To leave this field blank, press Enter.

5. Press Enter.

6. Do one of the following:

   ♦ Add another entry.

   ♦ Exit the new data entry mode by selecting Cancel.

The digits 0 - 9 plus * and # are valid entries for extension numbers. You can also enter the character P to insert pauses. The first P provides a two second pause and enables Tone Signaling. Subsequent P’s provide additional two second pauses. This is useful for accessing a voice mail system or other device controlled by DTMF tones. Example: 1234PPP*5678. 1234 might be a voice mail extension number. The first P enables Tone Signaling and provides a two second pause. The next two P’s allow time for the voice mail system to answer (your system may require more or less time). *5678 might be the password digits for a specific mail box.
Deleting an Entry

To delete a Phone Book entry:

1 - Select the entry you want to delete.
   Use the scroll bar on the right or the ↑↓ keys to move up or down through the list.
   You can also use the Find command to locate the entry. See Finding an Entry below.

2 - Choose Delete from the Edit menu or press DEL.

3 - Select OK to delete the entry.

Finding an Entry

To find an entry in the Phone Book:

1 - Select Find from the Search menu or press F5.

2 - Type the name (or a portion of it), and then press Enter.
   If you make a mistake, press ESC, and then re-enter the name.

3 - Press Enter to start the search.
Appendix A: Using the Phone Book Editor

Changing an Existing Entry

1 - Select the entry you want to modify.
   Use the ↑↓ keys or the scroll bar beside the list of names to move up or down through the list.
   You can also use the Find command to locate the entry. See Finding an Entry above.

2 - Select Modify from the Edit menu or press F4.

3 - Make the changes, and then press Enter.
   To leave an entry unchanged, press Enter.

The modified name or number must not match existing entries in the Phone Book.

Showing All Entries

Use this procedure following a search to display all entries in the Phone Book.

To show all entries in the Phone Book:
- Select Display All from the Search menu or press F6.
  Use the ↑↓ keys or the scroll bar beside the list of names to move up or down through the list.

Printing the Phone Book

To print the Phone Book:

1 - Select Print from the File menu or press F2.

2 - Choose a printer, and then select OK.
Appendix B: Reference
## Telephone Directory

<table>
<thead>
<tr>
<th>Name</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>POLICE:</td>
<td></td>
</tr>
<tr>
<td>FIRE:</td>
<td></td>
</tr>
<tr>
<td>HOSPITAL:</td>
<td></td>
</tr>
<tr>
<td>TROUBLE WITH EXTENSION OR CONSOLE:</td>
<td></td>
</tr>
</tbody>
</table>
# Abbreviated Dialing List

<table>
<thead>
<tr>
<th>Index Number</th>
<th>Identity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Class of Service/Restriction

Each extension and trunk has a COS (Class of Service) and a COR (Class of Restriction) that defines what the user of that extension or trunk can or cannot do. The system can have up to 50 of each, although most companies use only a few.

To help you answer questions from users who may be having problems with the system, you may want to record a brief description of the most common COSs and CORs. For example, COS 1 might mean, “Allows only local calls,” and COR 10 might be, “No long distance calls after 6 PM.” Your communications department can give you the required details.

### COS

<table>
<thead>
<tr>
<th>COS</th>
<th>COS NAME</th>
<th>ALLOWS...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### COR

<table>
<thead>
<tr>
<th>COR</th>
<th>COR NAME</th>
<th>Restricts...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix B: Reference

Console Screen Abbreviations

<table>
<thead>
<tr>
<th>Abb.</th>
<th>Meaning</th>
<th>Abb.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABBR</td>
<td>Abbreviated</td>
<td>FLEX</td>
<td>Flexible</td>
</tr>
<tr>
<td>ACC</td>
<td>Account</td>
<td>FWD</td>
<td>Forwarding</td>
</tr>
<tr>
<td>ANSR</td>
<td>Answer</td>
<td>IDENT</td>
<td>Identity</td>
</tr>
<tr>
<td>ATT</td>
<td>Attendant</td>
<td>INT</td>
<td>Intercept/Internal</td>
</tr>
<tr>
<td>BSY OUT</td>
<td>Busied Out</td>
<td>LD</td>
<td>Long Distance</td>
</tr>
<tr>
<td>CAN</td>
<td>Cancel</td>
<td>LDN</td>
<td>Listed Directory Number</td>
</tr>
<tr>
<td>CBK</td>
<td>Callback</td>
<td>LOC</td>
<td>Local</td>
</tr>
<tr>
<td>CDE</td>
<td>Customer Data Entry</td>
<td>MSG</td>
<td>Message</td>
</tr>
<tr>
<td>CLR</td>
<td>Clear</td>
<td>MSW</td>
<td>Message Waiting</td>
</tr>
<tr>
<td>COR</td>
<td>Class of Restriction</td>
<td>OCC</td>
<td>Occupied</td>
</tr>
<tr>
<td>COS</td>
<td>Class of Service</td>
<td>RCL</td>
<td>Recall</td>
</tr>
<tr>
<td>C/W</td>
<td>Call Waiting</td>
<td>REG</td>
<td>Register</td>
</tr>
<tr>
<td>DD/MM/YY</td>
<td>Day/month/year</td>
<td>RLS</td>
<td>Release</td>
</tr>
<tr>
<td>DISA</td>
<td>Direct Inward System Access</td>
<td>RM</td>
<td>Room</td>
</tr>
<tr>
<td>DISTB</td>
<td>Disturb</td>
<td>RS</td>
<td>Room Status or Restricted Outgoing Calls</td>
</tr>
<tr>
<td>DND</td>
<td>Do Not Disturb</td>
<td>SER</td>
<td>Serial</td>
</tr>
<tr>
<td>DST</td>
<td>Destination</td>
<td>VAC</td>
<td>Vacant</td>
</tr>
</tbody>
</table>
System Messages for SUPERSET Display Telephones

The following default messages can appear on all SUPERSET telephones equipped with displays.

<table>
<thead>
<tr>
<th>Message Number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>IN MEETING</td>
</tr>
<tr>
<td>02</td>
<td>OUT OF TOWN</td>
</tr>
<tr>
<td>03</td>
<td>ON VACATION</td>
</tr>
<tr>
<td>04</td>
<td>OUT ON A CALL</td>
</tr>
<tr>
<td>05</td>
<td>OUT TO LUNCH</td>
</tr>
<tr>
<td>06</td>
<td>GONE FOR THE DAY</td>
</tr>
<tr>
<td>07</td>
<td>GONE HOME</td>
</tr>
<tr>
<td>08</td>
<td>IN TOMORROW</td>
</tr>
<tr>
<td>09</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
</tr>
</tbody>
</table>

Authorized SUPERSET users can change these messages and program seven more for system-wide use. Keep a record of any changes and additions.

For instructions on setting these messages from the console, see Setting and Clearing Advisory Messages on page 54.
Appendix B: Reference

Glossary

**Busy-out**
A feature allowing you to make a line or equipment indicate busy to an incoming call. In effect, you take the line out of service until it can be repaired or tested.

**Camp-on**
A feature allowing the system to queue calls directed to a busy extension, and then automatically connect the waiting party when the extension becomes free. The busy extension hears a quick beep to indicate a call is waiting.

**Central Office (CO)**
A facility housing the public telephone system and related equipment which provides telephone service for customers in a geographical area.

**Class of Restriction (COR)**
When the system is programmed, the extensions and trunks are assigned to different Classes of Restriction. A COR controls the outgoing call capabilities of the extension or trunk. For example, an extension can be assigned a COR that prevents it from making outside calls other than with the assistance of the operator.

**Class of Service (COS)**
When your telephone system is programmed, the extensions are assigned to different Classes of Service. Each class has access to a specific set of features.

**DISA (Direct Inward System Access)**
A feature which allows callers to dial directly into the telephone system and use its features and facilities.

**Hardware**
The physical components of the system.
**Glossary**

**Hunt Group**
Extensions assigned to a group with a common (pilot) telephone number as well as their own personal extension numbers. An incoming call to a hunt group will ring the first available extension.

**LDN Keys (Listed Directory Number)**
Call-handling keys which allow you to select the sequence in which you answer calls from outside the PABX.

**PABX (Private Automatic Branch Exchange)**
Telephone switching system for private use by a company.

**Recall**
A call which returns to the console after being transferred to a busy or unanswered extension.

**Software**
The routines, programs, and instructions required to run the system.

**Trunk**
A trunk (outside line) is the external communications link between two switching systems. This link can be between one or more telephone systems (PABXs) or the PABX and Central Office equipment.
Appendix B: Reference

Tone Demonstration

Your telephone system has several tones to inform you of the progress of your call. You can use the Tone Demonstration feature to familiarize yourself with the tones.

1 - Dial the Tone Demonstration access code _______. (Ask your communications department for the code.)

2 - Dial a two-digit tone code from the list below.

3 - Continue dialing codes to listen to other tones.

4 - Hang up when you are finished.

<table>
<thead>
<tr>
<th>Code</th>
<th>Tone Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Dial Tone</td>
<td>Heard when you lift the handset.</td>
</tr>
<tr>
<td>12</td>
<td>Transfer Tone</td>
<td>Heard at an extension when the user places a call on hold to consult with another party or to transfer the call.</td>
</tr>
<tr>
<td>13</td>
<td>Busy Tone</td>
<td>Heard when the number you dialed is busy.</td>
</tr>
<tr>
<td>14</td>
<td>Special Busy Tone</td>
<td>Heard when the extension you called has Do Not Disturb activated.</td>
</tr>
<tr>
<td>15</td>
<td>Ringback Tone</td>
<td>Heard when the destination you dialed is ringing.</td>
</tr>
<tr>
<td>16</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Reorder Tone (Error Tone)</td>
<td>Heard when a feature is not available to you or not in your Class of Service, or when you dial an invalid number.</td>
</tr>
<tr>
<td>18</td>
<td>Conference</td>
<td>Heard when a new person joins a conference call.</td>
</tr>
<tr>
<td>19</td>
<td>Call Waiting Tone (Camp-on)</td>
<td>Heard during a conversation when you have an internal call waiting to be answered.</td>
</tr>
<tr>
<td>20</td>
<td>Intrusion Tone (Override)</td>
<td>Heard by all parties in a conversation when someone overrides (intrudes into) a call.</td>
</tr>
<tr>
<td>21</td>
<td>Interrupted Dial Tone</td>
<td>Heard when you lift the handset at an extension that has Do Not Disturb or Call-Forward Always activated.</td>
</tr>
<tr>
<td>22</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Waiting on Hold Tone</td>
<td>Heard by a caller on hold and during camp-on.</td>
</tr>
</tbody>
</table>
## Tone Demonstration

<table>
<thead>
<tr>
<th>Code</th>
<th>Tone Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>Paging Tone</td>
<td>Heard when you are connected to the loudspeaker paging equipment.</td>
</tr>
<tr>
<td>25</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Trunk Camp-on Double Beep Tone</td>
<td>Heard during a conversation when you have an external call waiting.</td>
</tr>
<tr>
<td>27</td>
<td>ARS Expensive Warning Tone</td>
<td>If your system has Automatic Route Selection (ARS), you will hear this tone when no inexpensive routes are available for your long-distance call. The tone is a warning that your call is taking an expensive route.</td>
</tr>
<tr>
<td>28</td>
<td>ARS Dial Tone</td>
<td>If your system has Automatic Route Selection (ARS), you will hear this tone after you dial the trunk access code.</td>
</tr>
<tr>
<td>29</td>
<td>Override Warning Tone</td>
<td>Heard by all parties in a conversation when someone overrides (intrudes into) the call.</td>
</tr>
<tr>
<td>30</td>
<td>Privacy Release Tone</td>
<td>Heard when privacy is released on a SUPERSET telephone and the new member joins the call.</td>
</tr>
<tr>
<td>31</td>
<td>Auto Answer Call End Tone</td>
<td>Heard by a user that has a SUPERSET in Auto-Answer mode when the calling party hangs up.</td>
</tr>
<tr>
<td>32</td>
<td>Attendant Error Tone</td>
<td>Heard by the Attendant, when attempting to do something that is not allowed, such as trying to connect two devices that are not allowed to be connected.</td>
</tr>
<tr>
<td>33</td>
<td>Ringer Pitch Adjustment</td>
<td>Dialed at SUPERSET telephones to hear adjustments to ringer pitch.</td>
</tr>
</tbody>
</table>
Appendix B: Reference

**Trunk Identification**

<table>
<thead>
<tr>
<th>Trunk Number</th>
<th>Identity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Index
Index

Numerics
911 call alarms, viewing and clearing, 40

A
Abbreviated Dialing numbers, entering and viewing, 44
abbreviations, console screen, 84
accessing specific trunks, 61
Advisory Messages
calling extensions with Advisory Messages, 22
list of Advisory Messages, 85
setting and clearing on extensions, 54
alarms, viewing and clearing, 59
All Set Page, 28
answering calls
multiple calls waiting, 19
new call indication, 19
new calls, 18
when Night Service enabled, 33
Application area, console screen, 7
applications, accessing, 47
audits (printouts) for guest rooms, 72
Auto Answer, using, 14

B
bell, See ringer
blocking calls between guest rooms, 71
Bookutil, 75
busy
recalls, 26
transferring to busy extensions, 21
busy out
definition, 86
extensions, 55
trunks, 62

C
C/W indicator, 18
cadence, ringer, 11
call Block, 71
call forwarding
cancel on all extensions, 42
setting and canceling on individual extensions, 51
call restrictions for guest rooms, 70
call splitting, 25
Callback
about, 21
canceling on all extensions, 42
leaving at an extension, 21
call-handling keys, 8
call-handling keys, 17
camp-on, definition, 86
canceling
Advisory Messages, 54
all call forwarding, 42
all callbacks, 42
Call Forwarding on individual extensions, 51
Do Not Disturb on individual extensions, 28, 52
Message Waiting on individual extensions, 29, 55
CAS, See Centralized Attendant Service
CDE (Customer Data Entry), 47
Central Office, definition, 86
Centralized Attendant Service, 54
Class of Restriction, definition, 86
Class of Service, definition, 86
disabling SUPERSET 7000, 10
Command and Response area, console screen, 7
conferences, setting up, 25
Index

console
  adjusting, 11
  changing language, 13
components, 7
directory number, displaying, 46
intercepts, 27
language, changing, 13
lockout, 13
monitor, 7
Night/Day Service, switching, 12
ringer, adjusting volume and cadence, 11
ringer, turning on/off, 12
screen abbreviations, 84
custom key, about, 8
cursor control keys, 8
custom Data Entry, 47

date, setting, 41
day service, switching, 12
dial pad keys, about, 8
dialing mistakes, correcting, 20
directed call pickup, 35
directory number, display console, 46
DISA
  access codes, changing, 43
definition, 86
DND
  overriding, 21, 29
  setting and canceling on an extension, 28, 52
do not disturb, see DND

emergency
  911 call alarms, viewing and clearing, 40
exit superset 7000, 10
extending calls, see transferring calls

f
  flashing on trunks, 52
  flexible night answer, 45
french, console language, 13

G
Group Ringing, 28
Guest Room
  blocking room-to-room calls, 71
  calling restrictions, 70
  changing occupancy and condition status, 68
  display and changing room data, 65
  displaying and clearing message register, 71
  listing rooms by occupancy and condition status, 67
  printing status, 72
  wake-up calls, 69

H
  hand set volume, adjusting, 12
  hardware, definition, 86
  headset volume, adjusting, 12
hold
  pickup, 24
  placing calls on, 23
  recall, 24
  retrieving calls on hold, 23
  stacked, 24
hotels, motel features, see guest room
Hunt Group, definition, 87

I
identity
  console, 46
  system, 46
installing superset 7000, 4
intercepts to console, 27

K
keyboard, console, 8

L
language, changing on console, 13
last number dial, 31
LDN (Listed Directory Number), definition, 87
lockout console, 13
Index

M

main screen, returning to, 11
making calls, 22
Message Register
displaying and clearing, 71
printing, 72
Message Waiting
reading messages, 53
setting and canceling on an extension, 29, 53
minimum PC requirements to run SUPERSET 7000, 3
misdialed numbers, correcting, 20
monitor
 about the console, 7
multiple console operation, 34

N

new call indication, 19
night answering points, setting up, 45
Night Service
 answering calls when Night Service enabled, 33
setting up answering points, 45
switching, 12
no answer recalls, 26

O

outgoing calls, allowing/restricting from guest rooms, 70
override busy and Do Not Disturb, 29

P

PBX, definition, 87
paging, 27
PBX programming requirements, 4
PC requirements to run SUPERSET 7000, 3
Phone Book Editor
 about, 75
adding entries, 76
deleting entries, 77
editing entries, 78
finding entries, 77
opening and closing, 75
printing, 78
showing all entries, 78
Phone Book, using, 30
picking up calls on hold at the console, 24
placing calls, 22
printing guest room reports, 72
printing, Phone Book, 78

R

recalls
 answering, 26
definition, 87
redialing, last number redial, 31
restricting calls from guest rooms, 70
returning to main screen, 11
ringer
 adjusting volume and cadence, 11
turning on/off, 12
room status
 changing, 68
listing by occupancy and condition status, 67
room-to-room calls, restricting, 70

S

screen, abbreviations, 84
Serial Call, 31
service
 switching to Day/Night, 12
taking extensions in or out, 55
taking trunks in or out, 62
Set Paging, 28
Softkeys, about, 8
software version, displaying, 46
software, definition, 87
sound card, 5
Spanish, console language, 13
splitting conferences, 25
stacked hold, 24
starting SUPERSET 7000, 10
Status area, console screen, 7
SUPERSET 7000
 installing, 4
starting and closing, 10
SUPERSET telephones
 calling SUPERSETs with Advisory Messages, 22
list of Advisory Messages, 85
setting and clearing Advisory Messages, 54
system
 alarms, viewing and clearing, 59
identification, displaying and changing, 46
software version, displaying, 46
time and date, setting, 41
system requirements to run SUPERSET 7000, 3
System Speed Calling numbers, See Abbreviated Dialing numbers
Index

T
TALK TO card, 3, 4
time, setting, 41
tone demonstration, 88
Tone Signaling
   enabling/disabling tones, 52
   voice mail, 35
transferring calls, 20, 34
trunks
   accessing specific, 61
   busy out, 62
   definition, 87
   flashing, 32
   viewing status of individual trunks, 59
   viewing status of trunk groups, 60

V
voice mail, affect on console operations, 55

W
wake-up calls
   printing, 72
   setting and canceling, 69